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Note

Before using this information and the product it supports, read the information in “Notices” on page 37.

This edition applies to version 4.5.0 of IBM Enterprise Content Management (product number 5724-R75), and to all
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
subsequent releases and modifications until otherwise indicated in new editions.

© Copyright International Business Machines Corporation 2001, 2008.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.
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Revision log

The following table identifies changes made to this document since the IBM Enterprise Content 
Management Widgets release.

Date Revision

11/08 Initial release of this document for release 4.5. 
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About this document

This document provides installation information about IBM Enterprise Content Management 
Widgets. 

Intended audience
This document is intended for software professionals who install IBM FileNet products. IBM 
recommends that an IBM FileNet Certified Professional (FCP) perform the installation. For more 
information about the FCP program, contact your IBM service representative.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Typographical conventions
This document uses the following typographical conventions:

Convention Usage Example

Bold Platform-specific headings Start the application server.

WebSphere

Refer to IBM WebSphere documentation for 
more information.

WebLogic

Refer to BEA WebLogic documentation for 
more information.

Gray bold Clickable items, such buttons, 
and tabs.

Click OK.

Menu paths or breadcrumb 
trails.

Select Start > Settings > Control Panels > 
Display > Screen Saver. 

Italics Variables that require user-
supplied values

The calculation is: number of object stores * 
16 + number of concurrent users.

Document titles You are reading the IBM FileNet P8 Platform 
Installation and Upgrade Guide.

Monospace Text that has to be typed by 
the user 

Copy the file by entering the following 
command:

COPY filename

Code samples Find the following text in the web.xml file:

<context-param><param-name>uploadDir</
param-name><param-value>/opt/FileNet/AE/
Upload1</param-value> </context-param>

Display text, such as prompts 
and error messages

Are you sure you want to delete this 
object?
You do not have permission to delete this 
object.

Elements such as filenames, 
properties, classes and so on, 
whose meaning might get 
confused in regular text. 

Open the filed file.

Enter a value for the new property.

Select the senior class.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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“Text with 
quotation 
marks”

User-interface fields that do 
not use initial capitalization 
and document headings 
referenced within a document

See the “Part number” field for the part 
number.

For more information, see “Typographical 
conventions” on page 8. 

UPPERCASE Case-sensitive text, where 
uppercase text is required.

Copy the file by entering the following 
command:

COPY filename

Convention Usage Example
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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About IBM FileNet documentation
By default, this document is distributed as part of the IBM FileNet P8 help system, but it is also 
available as a downloadable document from the IBM support Web site. Newer versions of IBM 
FileNet P8 documentation are sometimes re-released with other events, such as fix pack releases 
or documentation refreshes. To ensure that you have the latest revision of a document, compare 
the document part number of your document to the document part number of the document that is 
posted on the support Web site: 

www.ibm.com/support/docview.wss?rs=3278&uid=swg27010422

For example, the last two digits of “GC31-5585-05” indicate that the specified document has been 
revised five times after the original publishing, which is designated by 00.

Links to additional information
To help you locate additional information about a topic, this document includes links to:

• Other locations in this document

• External Web sites 

• Topics in the FileNet P8 help system

Because this document is included in the default FileNet P8 help system, the links to the FileNet 
P8 help topics work only when you view this document from within the help system. If you view 
this document from outside of the help system, the links to FileNet P8 help topics do not work.

Gather reference documentation
The following table provides information about the IBM FileNet P8 documents that are available as 
part of the FileNet P8 release. To download these documents from the IBM FileNet support Web 
site, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 11. 

Installation reference documents

Consider having one or more of the following documents (or help topics) nearby for reference 
purposes during the installation of IBM FileNet P8 Platform. 

Document or help topic name... Refer to this document...

IBM FileNet P8 Hardware and Software 
Requirements

To confirm that the target environment has at least 
the minimum supported levels of software from 
independent software providers.

IBM FileNet P8 Compatibility Matrix To confirm that the version of FileNet product to be 
installed is compatible with at least the minimum 
supported levels of other FileNet products that are 
or will be used with FileNet P8.

IBM FileNet P8 Release Notes To familiarize yourself with the new features and 
known issues associated with the FileNet product 
release.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Access IBM FileNet documentation, compatibility matrices, and fix 
packs
To access documentation, compatibility matrices, and fix packs for IBM FileNet products: 

1. Navigate to the Product Documentation for FileNet P8 Platform support page.
(http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422).

2. Select a PDF or a Doc Link, whichever is appropriate.

Customer support
For information about contacting customer support: 

1. Navigate to the FileNet Product Family support page: 
(http://www-01.ibm.com/software/data/content-management/filenet-product-family/support.html). 

2. Click IBM FileNet Support Communications, or search for a particular support topic under 
“Enter search terms”. 

Feedback
Your feedback helps us to provide quality information. Send your comments about this publication 
or any other IBM FileNet documentation by e-mail to comments@us.ibm.com. Be sure to include 
the name of the product, the version number of the product, and the name and part number of the 
book (if applicable). If you are commenting on specific text, include the location of the text (for 
example, a chapter and section title, a table number, a page number, or a help topic title).

Plan and Prepare Your Environment for 
IBM FileNet P8

To confirm the target environment is ready for a 
FileNet P8 installation or upgrade.

IBM FileNet P8 Non-English Support 
Guide

For information about how FileNet P8 supports non-
English environments.

Document or help topic name... Refer to this document...
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE

http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422
http://www-1.ibm.com/support/docview.wss?rs=3247&uid=swg27010422
mailto:comments@us.ibm.com


 Installation and deployment tasks
To install IBM Enterprise Content Management Widgets

12

IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE

Installation and deployment tasks

To install IBM Enterprise Content Management Widgets

1. Perform pre-installation tasks. Do Task 1 on page 13.

2. Install the ECM Widgets documentation on the application server (Task 2 on page 17).

3. Install ECM Widgets (Task 3 on page 18).

4. Deploy ECM Widgets to the Lotus Mashups server (Task 4 on page 20).

5. Deploy the default pages to the Lotus Mashups server (Task 5 on page 22).

6. Optionally, share the default pages (Task 6 on page 24).

7. Perform configuration tasks (starting on page 25).

NOTES

• To deploy ECM widgets and default pages, InfoSphere MashupHub, Lotus Mashups, and the 
FileNet P8 Platform must be running.

• Install and uninstall operations are recorded in log files. The locations of these files are 
specified in the install and uninstall procedures.
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Task 1: Perform pre-installation tasks

Verify installation of server software
Before you install and deploy IBM Enterprise Content Management Widgets (IBM ECM Widgets), 
verify the following server software is installed and configured:

• FileNet P8 System. P8 System is typically installed on its own set of servers.

• Microsoft Windows Server platform, and software required by IBM ECM Widgets, as outlined 
below.

For the complete list of IBM ECM Widgets requirements, see the IBM FileNet P8 Hardware and 
Software Requirements. To download this document from the IBM web site, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 11.

To install software required by ECM Widgets

1. Using the IBM Mashup Center installer, install Lotus Mashups and MashupHub, which bundle 
WebSphere application server 6.1.0.13.

NOTE For IBM Mashup Center installation details, see the IBM Mashup Center wiki.

a. For performance and scalability enhancements, it is recommended that you configure DB2 
as opposed to the file system.

b. Apply Fixpack v1.0.0.1 to the Mashup Center.

2. Install Workplace XT on the same WAS server as Lotus Mashups.

NOTES  

– In the Workplace XT Installation and Upgrade Guide, ignore Single Sign On (SSO) 
configuration instructions.

Table 1: ECM Widgets Server Requirements

Server Platform Software

Microsoft Windows Server 2003 
SPx:

Enterprise Edition with Service 
Pack 1 (32–bit)

or

Standard Edition with Service 
Pack 2

• IBM Mashup Center 1.0 Windows Multilingual 
(Mashup NLV version). 

• WebSphere 6.1.0.13 Application Server (WAS). 

• Workplace XT v1.1.3 (must be installed on the same 
WAS server as IBM Mashup Center).

• Process Engine REST API, via the PE Client 
Installer

• Optional: FileNet P8 eForms 4.0.2.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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– In a production environment, we recommend that you do not use the same instance of 
Workplace XT for both ECM Widgets usage and for standard P8 Platform usage. Separate 
Workplace XT instances enable the systems to be tuned for performance based on usage. 
In a development environment, joint usage with a single instance of Workplace XT is 
acceptable.

3. Install PE Client on the same WAS server as Lotus Mashups.

NOTE  When installing the PE Client, choose the option to install Process Engine REST API. 
(By default, the API is not installed.) 

4. Install CE Client on the same WAS server as Lotus Mashups.

5. Configure Mashup Server to access the same LDAP server that the P8 System uses for 
authentication.

6. (Optional) Install FileNet P8 eForms.

7. Using WebSphere Administrative Console, configure ECM Widgets, Workplace XT and Lotus 
Mashups to avoid potential session timeout issues. Perform the following steps:

a. From the Enterprise Applications page, click the application name, for example, 
WorkplaceXT, or mm.was.ear.

b. Click session management.

c. On the session management page, select the Override session management checkbox, and 
click Enable Cookies.

d. In the Cookie path text box, enter a path to store the application’s cookies. For Workplace 
XT for example, you could enter /WorkplaceXT. Enter a different path for each application.

e. Apply your changes.

f. When you have completed the above sequence of steps for all of the applications, go to the 
Enterprise Applications page and restart ECMWidgets, WorkplaceXT, and mm.was.ear.

Verify installation of client software

NOTE  If you use Mozilla Firefox, install the Long Titles add-on from the Mozilla Web site, so that 
you can view all of the text in the tooltips.

Table 2: ECM Widgets Client Requirements

Client Platform Software

Windows VISTA

or

Windows XP SP2

Internet Explorer 7.x

Mozilla Firefox 2.0.x
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Identify LDAP groups for ECM Widgets
In your P8 LDAP configuration, identify the groups that will interact with IBM Mashup Center and 
ECM Widgets. For example, consider which groups can share and automatically accept mashup 
pages, and which groups can edit or view mashup pages.

As a guideline, the following table lists typical Business Process Management (BPM) groups and 
describes their interaction with ECM Widgets. Additional groups may be needed, depending on 
your application requirements and the target deployment environment.

Set automatic acceptance of shared pages
To give users access to a newly created mashup page, the owner must specify which users can 
use the page, and the users must manually accept the shared page before they can access it. To 
optimize this process, all BPM users who will use mashup pages should be defined in an LDAP 
group, and that group should be configured to automatically accept shared pages. Otherwise, the 
owner of a new page must notify all BPM users to manually accept the shared page.

To configure automatic acceptance of pages

1. Open bootstrap2.jsp in

 install_path\IBM Mashup Center\mm\eclipse\plugins\mm.enabler_1.0.0\resources\boostrap

2. Change the setting of the JavaScript variable autoAcceptSharedGroupName to the LDAP group 
defined with all BPM application users.

3. Restart WebSphere Application Server.

NOTE  If the user has already logged into Lotus Mashups, then the pages will not be shared 
automatically.  Also, if you add a user to the LDAP group for which mashup pages have previously 
been shared, then those pages will not apply to the new user. To apply previously shared pages to 
the new user, you must share them with the individual user, then notify the user to manually 
accept the pages.

Group Description

BPM Application Administrators Administers IBM Lotus Center and P8 installations, 
including IBM ECM Widgets and upgrades. 

Set this group to edit mashup pages.

BPM Application Designers Creates role and step processor pages. 

Set this group to edit mashup pages.

BPM Application Users All users who need to use the application.

Add application designers and administrators to this 
group. 

Set this group to automatically accept shared pages, 
and to view mashup pages with ECM widgets.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Plan for Non-English environment installation
NOTE  For details on the supported levels of third-party software components and version 
requirements for non-English installations, refer to the IBM FileNet P8 Hardware and Software 
Requirements Guide, and the topic “Non-english environment considerations“ in the Plan and 
Prepare Your Environment for IBM FileNet P8 guide. To download these documents from the IBM 
web site, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 11.

To download this document from the IBM support page, see “Access IBM FileNet documentation, 
compatibility matrices, and fix packs” on page 10.

Language support for ECM Widgets
ECM Widgets is Unicode enabled to support multiple languages; however ECM Widgets is 
dependent on the Process Engine language support. For more information on non-English 
environment considerations see the IBM FileNet P8 Non-English Support Guide. To download this 
document from the IBM web site, see “Access IBM FileNet documentation, compatibility matrices, and 
fix packs” on page 11.

Available languages
ECM Widgets provides the Multilingual user interface files so a separate installation step is not 
required to install the translated version.  For more information about available languages, 
translated user interface, display settings, and functionality related to localized components, see 
the IBM FileNet P8 Non-English Support Guide. To download this document from the IBM web 
site, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 11.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Task 2: Install the IBM ECM Widgets documentation on 
the application server
Before you install IBM ECM Widgets, ensure that at least version 4.5 of the IBM FileNet P8 
Platform documentation is installed on your IBM FileNet P8 documentation server. Version 
information is available in the IBM FileNet P8 help topic Help Directory > About the documentation - 
IBM FileNet P8 4.5. Click the Documentation version and build information link for details.

To update your IBM FileNet P8 Platform documentation, download the zip file from the IBM 
Information Management support page (www.ibm.com/software/data/support/). For details on locating 
the appropriate files, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on 
page 11.

IBM recommends that you copy the PDF of this guide into the ecm_help/installation/
ecmwidgets_install directory on the documentation server before you re-index for the search 
function. That way, the guide is available for future use and is searchable from the IBM FileNet P8 
Documentation online help.

To install ECM Widgets documentation 

Because IBM ECM Widgets is an expansion product for IBM FileNet P8 Platform, you must add 
the associated ECM Widgets documentation to an existing installation of the IBM FileNet P8 
Platform Help. This action makes ECM Widgets help available to your users. 

For details and instructions on installing expansion product documentation, see the IBM FileNet 
P8 Platform Installation and Upgrade Guide. Pay special attention to the Install Expansion Product 
Documentation subtopic in the task Install IBM FileNet P8 Platform Documentation (your 
application server). To download this and other IBM FileNet product documentation from the IBM 
web site, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 11.

http://www.ibm.com/software/data/support/
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Task 3: Install ECM Widgets
This task includes IBM ECM Widgets installation instructions for the WebSphere Application 
Server on the Windows 2003 platform. The installer creates the IBM ECM Widgets folder structure 
and installs the files. 

You can run the installer interactively or silently. The silent install uses a response file, which 
requires preset responses. You can preset the responses in one the following ways:

• Manually modify the response file that is included with the installer.

• Run the interactive install to automatically capture your responses into a generated response 
file.

To install interactively, see “To interactively install the ECM Widgets software” on page 18. To install 
silently, see “To silently install the ECM Widgets software” on page 19.

After installing the files, you must deploy the IBM ECM Widgets, as described in “Deploy ECM 
Widgets to Lotus Mashups” on page 20.

To interactively install the ECM Widgets software

1. Launch ECMWidgets4_5_0WIN.exe.

2. Complete the Installation screens as follows:

In this screen... Perform this action...

Language Selection Choose the language of the installer UI, then click OK.

License Agreement Review and accept the license agreement, then click Next.

Save Response File Choose to install IBM ECM Widgets, save your install settings in a 
response file, or both.

Choose Install Folder Enter or browse to the location where you want to install the IBM 
ECM Widgets software. The default location is C:\Program 
Files\IBM\IBM ECM Widgets.

Pre-Installation Summary Verify the install parameters, click Install, and wait for installation 
to complete.

Install Complete If installation succeeded, click Done to exit the installer.

If you created a response file for silent installs, see the silent 
install procedure below.

NOTE  To view the installation log, see the 
ECMWidgets_InstallLog.log file located in install_path\ECMWidgets. 
Correct any errors before you proceed.
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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To silently install the ECM Widgets software

Unlike interactive mode, silent mode does not check that IBM ECM Widgets is already installed on 
the system. If the software is installed, the installer copies IBM ECM Widgets over the existing 
software.

1. Preset your responses in one of the following ways.

To use the response file included with the installer:

i. Copy the response file, ECMWidgets_silent_input.properties, to a local directory.

ii. Following the instructions in the response file, edit the file to reflect the appropriate 
responses for your installation. 

NOTE  Even if you accept all defaults in the ECMWidgets_silent_input.properties file, you 
must edit the file to accept the license agreement (-V licenseAccepted="true").

To generate a response file with the interactive install: 

i. Run the installer interactively, and choose to save a response file.

2. From the command prompt, navigate to and run the installer as follows: 

ECMWidgets4_5_0WIN –i silent -f “<path_to_response_file>\<response file name>”
IBM ENTERPRISE CONTENT MANAGEMENT WIDGETS INSTALLATION GUIDE
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Task 4: Deploy ECM Widgets to Lotus Mashups
Deploying IBM ECM Widgets is a two-step process, performed with the InfoSphere MashupHub. 
First, you upload the ECM Widgets package to the MashupHub catalog. Next, you add the 
collection of widgets in the package to Lotus Mashups server.

Should you need further instruction for a MashupHub page than what is stated here, see the help 
provided with MashupHub.

To deploy ECM Widgets to Lotus Mashups

1. Log into InfoSphere MashupHub.

2. Upload the ECM Widgets package to MashupHub. Complete the MashupHub pages as follows:

In this page... Perform this action...

Home On the Create panel, choose Upload Widget and 
click Next.

Upload Widget For the widget type source, choose iWidgets, and 
click Next.

Upload or Register a Widget For the widget source, choose Upload a Widget 
Package.

For the widget file path, enter 
install_path\ECMWidgets\ECMWidgets.war.

Click Next.

Specify the following information Enter information to identify IBM ECM Widgets. 
For the description, you may want to state that 
the widgets are used to construct P8 Business 
Process Management applications.

Click Finish. 

If the upload succeeds, the “iWidget successfully 
saved” page appears.

Iwidget successfully saved Choose View iWidget details. 

The details page for ECM Widgets appears. The 
exact name of the details page reflects the name 
you entered in the “Specify the following 
information” page.
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3. Add ECM Widgets to Lotus Mashups server. Complete the MashupHub pages as follows:

In this page... Perform this action...

Details page for ECM Widgets From the Actions menu, choose Add to Lotus Mashups.

Add to Lotus Mashups 1 of 2 NOTE  Depending on your IBM Mashup Center 
configuration and how you launched MashupHub, you 
may not get this page.

Enter the URL of Lotus Mashups and your account 
credentials.

Click Next.

Add to Lotus Mashups 2 of 2 Select a category. The categories listed correspond with 
the toolbox drawers that appear on a Lotus Mashups 
page in edit mode.

Click Finish.

If ECM Widgets are added successfully, a page appears 
with that message.

ECM Widgets have been added to 
Mashups

You must add ECM widgets for every user who will use 
pages with ECM widgets embedded. Click View iWidget 
details, and repeat Step 3 for all remaining users.
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Task 5: Deploy default pages to Lotus Mashups
ECM Widgets provides default pages with pre-embedded ECM widgets. You can use these pages 
as a starting point for creating your own mashup pages with ECM widgets. There are two default 
pages, a home role page and a step processor page.

NOTE The default pages are in English. For non-English environments, you need to manually 
create default pages.

Deploying the default pages is a two-step process, performed with the InfoSphere MashupHub. 
You upload the first page to the MashupHub catalog, and then you add the page to Lotus Mashups 
server. You then repeat the process for the second page.

Should you need further instruction for a MashupHub page than what is stated here, see the help 
provided with MashupHub.

To deploy the default pages to Lotus Mashups

1. Log into InfoSphere MashupHub.

2. Upload an ECM Widgets default page to MashupHub. Complete the MashupHub pages as 
follows:

In this page... Perform this action...

Home On the Create panel, choose Upload Page.

Upload or Register a Mashup Page For the mashup page source, choose Upload a 
Mashup Page Package.

For the mashup page file path, browse to 
install_path\ECMWidgets\SamplePages. Select Role 
Main Page.xml or Step Processor Page.xml.

Click Next.

Specify the following information Enter information to identify the page. For example, 
for the title, you can enter “ECM Widgets role home 
page” or “ECM Widgets step processor page”. 

Click Finish. If the upload succeeds, the “Mashup 
page successfully saved” appears.

Mashup page successfully saved Choose View mashup page details. 

Details page for the uploaded ECM Widgets default 
page appears. The exact name of the details page 
reflects the name you entered in the “Specify the 
following information” page.
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3. Add the ECM Widgets default page to Lotus Mashups server. Complete the MashupHub pages 
as follows:

4. Log out of MashupHub.

In this page... Perform this action...

Details page for ECM Widgets 
default page

From the Actions menu, choose Add to Lotus 
Mashups.

Add to Lotus Mashups 1 of 2 NOTE  Depending on your IBM Mashup Center 
configuration and how you launched MashupHub, you 
may not get this page.

Enter the URL of Lotus Mashups and your account 
credentials.

Click Next.

Add to Lotus Mashups 2 of 2 If necessary, edit the title and description.

Choose the location of the default page relative to the 
location of other pages. You can make the page a top-
level page or a child of an existing page.

Click Finish.

If the default page is added successfully, a page 
appears with that message.

Page has been added to Mashups. If you have not added both ECM Widgets default 
pages, click the MashupHub Home tab and return to 
Step 2 above.
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Task 6: Share default pages (optional)
For users to have access to the ECM Widgets default pages, you must share the pages with the 
users.

To share the default pages

1. Log into Lotus Mashups.

2. From the Page Navigator menu, choose one of the ECM Widgets default pages, the home role 
page or the step processor page.

3. From the Page Actions menu, choose Share this page. A “Permissions for the page” dialog box 
appears.

4. Do a search on the user group that you previously set to the JavaScript variable 
autoAcceptSharedGroupName. (For this group, shared pages will automatically display in each 
user's navigation when the user logs in for the first time.)

NOTE  If you share the page with users who are not in the group that is set to the 
autoAcceptSharedGroupName variable, then those users must manually accept the shared page.

5. From the Search Results panel, drag and drop the group to either the Add to View or Add to Edit 
panel.

6. Choose Save. 

7. Repeat this procedure for the second ECM Widgets default page.

NOTES

• If you later add new users to the group configured to accept pages automatically, the default 
pages will not be available to the new users. To apply the default pages to the new users, you 
must share the pages with each individual user, then notify the users to manually accept the 
pages.

• The ECM widgets must be registered to all of the users with whom you shared the default 
pages. If the widgets are not registered for a user, they will display improperly for the user. 
This is a known issue in Lotus Mashups 1.0. See “Deploy ECM Widgets to Lotus Mashups” on 
page 20 for registering widgets to users.
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Configuration tasks

After ECM widgets and the default pages have been installed and deployed, you must perform the 
following configuration tasks:

• Configure Process Engine (PE) REST Services. See Task 1 on page 26.

• Configure ECM Widgets.See Task 2 on page 27

• Register default processor page. See Task 3 on page 28.

• Register Lotus Mashups base URL. See Task 4 on page 30.

• Enable email notification. See Task 5 on page 31.

If you are upgrading from Process Engine 3.5.3 or 4.0x, you also need to perform these tasks:

• Register email templates. See Task 6 on page 32.

• Add URL templates. See Task 7 on page 33.

With Process Engine configured for ECM Widgets, you’re ready to build user interfaces for FileNet 
BPM applications.

For an introduction to ECM Widgets, see the IBM FileNet P8 help topic Application Design > IBM 
ECM Widgets > Introduction.

For an overview of creating mashup pages with ECM Widgets, see the IBM FileNet P8 help topic  
Application Design > IBM ECM Widgets > Design Guide.

For details on creating roles, see the IBM FileNet P8 help topic User Help > Integrating Workflow > 
Workflow Applications > Process Configration Console > Manage Application Spaces > Create Roles. 
Roles associate users with home pages created with ECM Widgets. In the process of creating a 
role, you must specify the URL of the home page.

../../ecmwidgets_help/intro/intro_overview.htm
../../ecmwidgets_help/intro/intro_overview.htm
../../ecmwidgets_help/app_design/dg_overview.htm
../../pe_help/config/vwrolepropertypanel.htm
../../pe_help/config/vwrolepropertypanel.htm
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Task 1: Configure REST Services
When you ran the PE Client Installer as part of the pre-installation tasks, you installed the Process 
Engine REST API (also referred to as Process Engine REST Services) in Workplace XT.  For the 
REST API to establish a connection with the Process Engine, you must modify the default CE URL 
and Connection Point settings in the REST Services configuration file on Workplace XT. For 
details, see the IBM FileNet P8 help topic Developer Help > Process Engine Development > 
Developer’s Guide > Process Engine REST Service > Configuring REST Services.

../../developer_help/process_java_api/guide/rest/rest_configure.htm
../../developer_help/process_java_api/guide/rest/rest_configure.htm
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Task 2: Configure ECM Widgets
In order for ECM Widgets to communicate with the Process Engine REST API, you must configure 
the PE REST API URL and WorkplaceXT URL in the ECM Widgets application.

To configure ECM Widgets

1.  Open bootstrap.js in 
mm_home\mm_profile\installedApps\node\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm
\im\ecmwidgets.

2. Set the following three options in bootstrap.js:

• bpmServiceBaseURL -- the URL of the PE REST API. For example, http://localhost:9080/
WorkplaceXT/P8BPMREST/p8/bpm/v1.

• workplaceXTBaseURL -- the URL of Workplace XT. For example, http://localhost:9080/
WorkplaceXT.

• applicationSpace -- Process Engine application space. Unless you configure a different application 
space on the Process Engine, keep the default ("DefaultApplication").
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Task 3: Register the default step processor page
To use the ECM default step processor page, you must register it as both a launch processor and 
a step processor, as described in this task. Once registered, a Lotus Mashups launch processor 
and a Lotus Mashups step processor display in the list of available processors in Process 
Designer.

To use the ECM default home role page, you must register it when you create roles and in-
baskets. For details, see Process Designer help in the online FileNet P8 Documentation.

To register the default step processor page

1. If you already have the Process Configuration Console open, skip to Step 2. Otherwise:

a. Sign into Workplace XT.

b. From the Tools menu, select Administration, then choose the Process Configuration 
Console link.

c. From the tree view, select the Process Engine connection point, then right click and choose 
Connect.

d. From the tree view, select the Process Engine connection point, then right click and choose 
Properties. The Isolated Region Properties dialog box appears.

2. Click the Step Processor tab.

3. Click the Add icon in the right corner.

4. Specify the step processor default page as a launch processor and as a step processor. Do this 
step twice, first for the launch processor and then for the step processor. Enter the following 
parameters and descriptions:

Column Parameter Description

Type Specify the entry as a launch processor or step processor.

Name Double-click the cell to enter a name that identifies the launch 
processor or step processor. We suggest that you use a name that 
describes the function of the processor, for example, “ECM Widgets 
default launch processor”. Each step and launch processor within the 
isolated region must have a unique name. Launch and step processors 
display in the list of available processors in Process Designer.

NOTE  Once you commit this change, you cannot change the name of 
the processor.

Language Select HTML.
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5. Press Enter.

6. Choose the OK button.

7. Click the Action button and choose Commit Changes. 

8. From the File menu of the Process Configuration Console, choose Exit.

9. Log out of Workplace XT.

Location Double-click the cell to open the Step Processor Info Location dialog 
box. Enter the page ID (pid) assigned to the default step processor 
page by Lotus Mashups. 

To get the page ID:

1. In Lotus Mashups, open the step processor default page.

2. In the browser address bar, copy the number that follows the “#pid=” 
portion of the URL, for example, 
09272B07FBD45F9CB4CF849B1B59F8000004.

3. In the Step Processor Info Location dialog box, paste the number 
into the Location cell for “IBM ECM Widgets for Lotus Mashups”.

4. Choose OK.

Height An integer value that specifies the height, in pixels, of the processor 
display window. You can experiment with this to find the optimal setting 
for your processor.

Width An integer value that specifies the width, in pixels, of the processor 
display window. You can experiment with this to find the optimal setting 
for your processor.

Class Name Ignore: this value does not apply to HTML-based processors.

Column Parameter Description
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Task 4: Register Lotus Mashups base URL
NOTE  You need to do this task only if you are going to enable email notification in Process Engine 
4.5, or if you are going to re-register email tempaltes after upgrading from Process Engine 3.5.3 
or 4.0x to Process Engine 4.5.

To register Lotus Mashups base URL

1. Sign into Workplace XT.

2. From the Tools menu, select Administration, then choose the Process Configuration Console 
link.

3. From the tree view, select the Process Engine connection point, then right click and choose 
Connect.

4. From the tree view, select the Process Engine connection point, then right click and choose 
Properties. The Isolated Region Properties dialog box appears.

5. Click the Web Applications tab.

6. In the “IBM ECM Widgets for Lotus Mashups” row, double-click the right-side cell.

7. Enter the Server Base URL in the following format:

http://<web_server>:<port>/mum/enabler

For example, http://mashupServer:9080/mum/enabler

8. Choose OK to close the dialog box.

9. Keep Process Configuration Console open and proceed to the next task.
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Task 5: Enable email notification
NOTE  

• Skip this task if you are upgrading from Process Engine 3.5.3 or 4.0x. See “Re-register email 
templates” on page 32.

• For email notification to work, you must also register the base URL for Lotus Mashups. See 
Task 4 on page 30.

The Process Engine 4.5 includes email templates that support ECM Widgets users. If you want 
ECM Widgets users to be notified of workflow activity by email, you need to enable and configure 
email notification. For details, refer to the IBM FileNet P8 Platform online documentation. To 
install the online documentation, see “Install the IBM ECM Widgets documentation on the application 
server” on page 17.

Using the table of contents in the left pane of the online help, navigate to the IBM FileNet P8 help 
topic FileNet P8 Documentation > System Administration > Process Engine Administration > Workflow 
Administration Tasks > Coordinate Workflow Design > Enable email Notification.

Process Engine supports localized email notification. For details on configuring this, see the IBM 
FileNet P8 Non-English Support Guide. To download this document from the IBM web site, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 11.
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Task 6: Re-register email templates
NOTE

• Do this task only if you are upgrading from Process Engine 3.5.3 or 4.0x.

• To use email templates with ECM Widgets, you must also register the base URL for Lotus 
Mashups. See Task 4 on page 30.

The Process Engine 4.5 includes email templates that support ECM Widgets users. To use these 
email templates, you must re-register all of the email templates for each language pact that you 
currently have installed on Process Engine. For details, refer to the IBM FileNet P8 Platform 
online documentation. To install the online documentation, see “Install the IBM ECM Widgets 
documentation on the application server” on page 17.

Using the table of contents in the left pane of the online help, navigate to the IBM FileNet P8 help 
topic FileNet P8 Documentation > System Administration > Process Engine Administration > Workflow 
Administration Tasks > Coordinate Workflow Design > Enable email Notification.

Click the add language packs link for details.
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Task 7: Add URL templates
NOTE  Do this task only if you are upgrading from Process Engine 3.5.3 or 4.0x.

Specify the launch and step processor templates for ECM Widgets. The Process Engine uses the 
templates to build the URL for the ECM Widgets launch and step processors. For details, refer to 
the IBM FileNet P8 Platform online documentation. To install the online documentation, see “Install 
the IBM ECM Widgets documentation on the application server” on page 17.

Using the table of contents in the left pane of the online help, navigate to the IBM FileNet P8 help 
topic FileNet P8 Documentation > User Help > Integrating Workflow > Workflow Applications > Process 
Configuration Console > VWServices > View or Modify VW Services Properties > Set URL Templates.

In the URL Templates dialog box, add the following templates for ECM Widgets: 

• Launch Step Processor URL Template:

{0}?workflowName={2}&subject={3}&attachmentId={4}&pid={1}

• Step Processor URL Template:

{0}?queueName={2}&wobNum={3}&stepName={4}&pid={1}



 Removing software
Undeploy ECM Widgets

34
Removing software

You can delete the ECM widgets and default pages from the InfoSphere MashupHub catalog and 
the Lotus Mashups server, and you can uninstall the ECM Widgets WAR file from the WebSphere 
Application Server. See “Undeploy ECM Widgets” on page 34.

You can also uninstall ECM Widgets from the installation directory. See “Uninstall ECM Widgets” on 
page 35.

Undeploy ECM Widgets
To undeploy ECM Widgets

1. Log into InfoSphere MashupHub.

2. Delete the ECM widgets and default pages from the MashupHub catalog. Complete the 
MashupHub pages as follows:

3. Log out of InfoSphere MashupHub.

4. Log into Lotus Mashups.

5. To delete the ECM widgets from Lotus Mashups:

a. Go to Edit mode.

b. From the Tools drawer in the Toolbox, select the edit icon next to an ECM widget, then 
choose Remove. Repeat for every ECM widget listed in the Tools drawer.

In this page... Perform this action...

Home On the Catalog panel, choose List Widgets.

Widgets Choose ECM Widgets.

ECM Widgets On the Actions menu, choose Delete.

Choose the Home tab.

Home On the Catalog panel, choose List Pages.

Pages Choose ECM Widgets Role Home Page.

ECM Widgets Role Home 
Page

On the Actions menu, click Delete.

Pages Choose ECM Widgets Step Processor Page.

ECM Widgets Step 
Processor Page

On the Actions menu, click Delete.
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6. To delete the ECM Widgets default pages from Lotus Mashups:

a. From the Page Navigator menu, choose one of the default pages, the home role page or the 
step processor page.

b. From the Page Actions menu, choose Delete this page. 

c. Repeat for the second default page.

7. Log out of Lotus Mashups.

8. Log into the WebSphere Admin Console.

9. To uninstall the ECM Widgets WAR file from WebSphere Application Server, complete the 
Admin Console pages as follows:

Uninstall ECM Widgets
To uninstall ECM Widgets

1. Launch install_path\ECM_Widgets\ECMWidgets_Uninstall\ECMWidgets_Uninstall.exe.

2. Complete the Uninstall screens as follows:

In this page... Perform this action...

Welcome From the navigation tree in the left pane, click 
Applications, then click Enterprise Applications.

Enterprise Applications Select the check box for ECM Widgets, and choose the 
Uninstall button.

At the top of the page, click Logout.

Uninstall Application Click OK.

Enterprise Applications In the Messages box, choose to save to the master 
configuration, or to review changes before saving.

Enterprise Applications Click Logout.

In this screen... Perform this action...

Introduction Click Next, and wait for uninstall to complete.

Uninstall Complete Click Done to exit the Uninstaller.

NOTE  To view the uninstall log, see 
install_path\ECMWidgets\TCCT_Uninstall.log1.
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This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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otice, and represent goals and objectives only.
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ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
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Trademarks
Trademarks

 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at ″Copyright and trademark information″ at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
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